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Welcome to R:BASE Dependency Viewer 11!

The R:BASE Dependency Viewer generates model for R:BASE
databases within a graphic environment using foreign key
relationships to display the relational design.
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1 Introduction

1.1 R:BASE Dependency Viewer 11

The R:BASE Dependency Viewer generates model for R:BASE databases within a graphic environment
using foreign key relationships to display the relational design.

The R:BASE Dependency Viewer connects directly to the database and imports the table structure to
create a model. Tables, column relationships, and indexes are available for display. The R:BASE
Dependency Viewer generates model for R:BASE databases within a graphic environment using foreign
key relationships to display the relational design. After structural changes are made for a database,
models can be refreshed to reflect dependency differences.

Images and text notes can be added tot he model to add detail to the displayed dependencies. Regions
can be added to group objects for an easier break down of database structure.

The R:BASE Dependency Viewer provides the ability to export the model as a PDF document. Printing
features allow for the model to be sent to a printer in several pages to for detailed mapping display. The
interfaces supports models to be saved and loaded from files. A database connection history is available
for time-saving use.

The R:BASE Dependency Viewer allows database administrators to:

· Quickly understand the database by graphically tracking database object dependencies
· Find potential orphans with no dependencies on other objects, to help clean up a database
· Quickly visualize areas of complexity with dependency diagrams 
· Analyze the potential impact of database schema changes 
· Rapidly document database dependencies for archiving, reporting, and version control

1.2 Copyrights

Information in this document, including URL and other Internet web site references, is subject to change
without notice. The example companies, individuals, products, organizations and events depicted herein
are completely fictitious. Any similarity to a company, individual, product, organization or event is
completely unintentional. R:BASE Technologies, Inc. shall not be liable for errors contained herein or for
incidental consequential damages in connection with the furnishing, performance, or use of this material.
This document contains proprietary information, which is protected by copyright. Complying with all
applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any
purpose, without the express written consent of R:BASE Technologies, Inc. We reserve the right to make
changes from time to time in the contents hereof without obligation to notify any person of such revision
or changes. We also reserve the right to change the specification without notice and may therefore not
coincide with the contents of this document. The manufacturer assumes no responsibilities with regard to
the performance or use of third party products.

Products that are referred to in this document may be either trademarks and/or registered trademarks of
the respective owners. The publisher and the author make no claim to these trademarks.

The software described in this document is furnished under a license agreement. The software may be
used or copied only in accordance with the terms of that agreement. Any unauthorized use or duplication
of the software is forbidden.

R:BASE Technologies, Inc. may have patents, patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in any
written license agreement from R:BASE Technologies, Inc., the furnishing of this document does not give
you any license to these patents, trademarks, copyrights, or other intellectual property.

Trademarks

R:BASE®, Oterro®, RBAdmin®, R:Scope®, R:Mail®, R:Charts®, R:Spell Checker®, R:Docs®, R:BASE
Editor®, R:BASE Plugin Power Pack®, R:Style®, RBZip®, R:Mail Editor®, R:BASE Dependency Viewer®,
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R:Archive®, R:Chat®, R:PDF Form Filler®, R:FTPClient®, R:SFTPClient®, R:PDFWorks®, R:Magellan®,
R:WEB Reports®, R:WEB Gateway®, R:PDFMerge®, R:PDFSearch®, R:Documenter®, RBInstaller®,
RBUpdater®, R:AmazonS3®, R:GAP®, R:Mail Viewer®, R:Capture®, R:Synchronizer®, R:Biometric®,
R:CAD Viewer®, R:DXF®, R:Twain2PDF®, R:Tango®, R:Scheduler®, R:Scribbler®, R:SmartSig®,
R:OutLink®, R:HASH®, R:JobTrack®, R:TimeTrack®, R:Manufacturing®, R:GeoCoder®, R:Code®,
R:Fax®, R:QBDataDirect®, R:QBSynchronizer®, R:QBDBExtractor®, and Pocket R:BASE® are
trademarks or registered trademarks of R:BASE Technologies, Inc. All Rights Reserved. All other brand,
product names, company names and logos are trademarks or registered trademarks of their respective
companies.

Windows, Windows 11-10, Windows Server 2022-2012, Bing Maps, Word, Excel, Access, SQL Server, and
Outlook are registered trademarks of Microsoft Corporation. OpenOffice is a registered trademark of the
Apache Software Foundation. 

Printed:  April  2024 in Murrysville, PA

First Edition

1.3 License

R:BASE TECHNOLOGIES, INC. LICENSE AGREEMENT
 

R:BASE Dependency Viewer 11
Single Seat License 

 
This is a legal agreement between you, the end user ("Licensee"), and R:BASE Technologies, Inc.
("RBTI"). Please read the terms and conditions of this License Agreement before using this software. By
you selecting "I accept the license agreement" and clicking "Next" during product installation means you
expressly accept the terms and conditions of this Agreement. If you do not accept the terms and
conditions of this Agreement, you must stop installing the Product and click "Cancel". Your money will be
refunded based upon proof of purchase, and in compliance with the return period described in the
LIMITED WARRANTY below. A violation of the License, brings damage both financially and to the
reputation of RBTI, and in the occurrence of either, both termination of the license agreement and civil
damages will be vigorously sought. Once you have clicked "I accept the license agreement", you are
entitled to use the Product under the following terms and conditions of this Agreement:

LICENSE
This RBTI License Agreement permits you to use one copy of the R:BASE Dependency Viewer computer
software with associated utilities (the “Program”) and accompanying user documentation (the
“Documentation”) on any single computer provided the Program is being used on only one computer at
a time. A Program is “being used” on a computer when it is loaded into a temporary memory or installed
on a hard drive in the computer. However, a copy of the Program installed on a network server for the
sole purpose of distribution to other computers is not “being used”. Each seat having access to the
Program must have an appropriate license. If you anticipate that the number of seats with access to the
Program will exceed the number of seats for which you are licensed, you must take steps to ensure that
the appropriate licenses are obtained for each seat.

COPYRIGHT AND RESTRICTIONS
RBTI retains full ownership rights in the Program and Documentation. You may make a single copy of the
Program; to be used solely for backup or archival purposes, or you may transfer the Program onto a
single hard disk provided you keep the original solely for backup or archival purposes. Such copies shall
be owned by RBTI. You may not copy any printed material or Documentation without prior permission.
You may not decompile, disassemble cross-compile, reverse engineer, or make or distribute any other
form of, or derivative work from, the Program. You may not obscure, alter or remove any RBTI
copyright, trademark or proprietary rights notices.

TRANSFER OF LICENSE
You may not lend, rent or lease the Program or Documentation or any copies to any person. A transfer
of license is only authorized through completion of the Consent to Assignment and Assumption of
Contract agreement from RBTI. Upon license transfer, you are permanently giving such person
possession of all copies of the Program and Documentation, are permanently giving up your right to use
the Program and Documentation, and the recipient agrees to the terms of this License Agreement. 
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STEP UPS AND UPGRADE PURCHASES
As the Licensee, you are authorized to use the Program only if you are an authorized user of a qualifying
product as determined by RBTI. The new license agreement takes the place of the agreement of the
qualifying software you stepped up or upgraded from. After you upgrade, you may no longer use the
software from which you upgraded. When you install the upgrade, you must uninstall the copy of the
qualifying product.

TERM OF LICENSE
The licensing provided in this License Agreement is perpetual unless you violate any of its terms or
conditions, at which time the license will automatically terminate. Upon termination you must return all
copies of the Program and Documentation to RBTI or certify in writing to RBTI that all such copies have
been destroyed and uninstalled from each workstation and/or network server. RBTI reserves the right to,
at its expense and without prior notice, conduct periodic inspections for licensing compliancy. If licensee
is found to be in violation of current agreement, RBTI may commence a civil action seeking fines,
damages, attorney’s fees and injunctive relief and may also, in appropriate circumstances, seek criminal
prosecution.

SOFTWARE SUPPORT
The availability of software support services is subject to the End of Support (EOS) and End of Life (EOL)
product life cycle, and to an active Software Assurance Plan. Where applicable, licensees will be provided
with an option to upgrade to the current supported version of a software product.

LIMITED WARRANTY
RBTI warrants to you, as the initial user, the Program will perform substantially in accordance with the
Documentation, provided it is used in unaltered form with functioning equipment and operating systems
for which it was designed. RBTI will, at its option, with proof of payment within 30 days of the invoice
date and after the Program with Documentation has been deactivated and uninstalled, and software
installer, whether provided by download or other means, permanently deleted from all drives and
folders, issue a full refund. These are your sole remedies for any breach of warranty. No exceptions will
be made.

SERVICES PROVIDED WITH PURCHASE

1. 30-Day Limited Complimentary Technical Support 

LICENSEE RESPONSIBILITIES

· To help us expedite the process and provide high quality assistance, the licensee must
provide proof of purchase when calling. Proof of purchase is defined as the following:
registration number, purchase date, version and build number, and company or individual to
which product is registered.

· To have operating system, workstations, and local network installed and functional. RBTI will
NOT be responsible for resolving issues not pertaining to the Program.

· Our support staff deals with advanced issues, therefore the person contacting RBTI for
assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES
· To provide quality assistance in a timely manner to aid Licensee in the installation of the

product within 30 days of the date of purchase.
· To provide a reasonable solution for any resolvable issue.  Not all issues are resolvable, and

therefore we will acknowledge the existence of known issues or “bugs” which we are
presently aware of, that have no reasonable work-around.

RBTI reserves the right to limit the amount of support time allotted to a maximum of 2 HOURS
during the 30-Day Complimentary Technical Support Period.  We also reserve the right to limit the
quantity of calls from a particular Licensee to 30 MINUTES in a single day.  Issues are dealt with
on a case-by-case basis, and are handled at the discretion of the support agent assigned to the
case. Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related
issues ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

2. Fixes for Known Issues
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RBTI will provide continued product fixes for known issues or “bugs” for 1 YEAR from the software
purchase date. After 1 year, users are urged to acquire the necessary Software Assurance Plan to
continue with product support and ongoing activations for reinstallations and license transfers.

3. Enhancement Requests
RBTI will provide continued product enhancements for requested features for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software Assurance
Plan to continue with product support and ongoing activations for reinstallations and license transfers.

NO OTHER WARRANTIES
Except as explicitly stated above, RBTI makes no express or implied warranties (including any warranties
of merchantability or fitness) with respect to the character, function, or capabilities of the program, the
documentation or their appropriateness for any user’s purposes. RBTI cannot customize product(s) to
meet specific needs in all cases. Examples of customization include, but are not limited to: special
character sets, foreign language adaptations, specific device drivers or other localization issues. Under
no circumstances will RBTI be held responsible for product functionality once alterations have been made
to accommodate individual needs.

DISCLAIMER OF WARRANTY
The Program and the accompanying files are sold "as is" and without warranties as to performance or
merchantability or any other warranties whether expressed or implied. Because of the various hardware
and software environments into which the Program may be put, No warranty of fitness for a particular
purpose is offered. Good data processing procedure dictates that any program be thoroughly tested with
non-critical data before relying on it. The user must assume the entire risk of using the Program. Any
liability of the seller will be limited exclusively to product replacement or refund of purchase price.

HIGH RISK ACTIVITIES
The Program is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, air traffic control, aircraft navigation or communication systems, direct life
support machines, or weapons systems, in which the failure of the Program could lead directly to death,
personal injury, or severe physical or environmental damage ("High Risk Activities"). RBTI specifically
disclaims any expression or implied warranty of fitness for High Risk Activities. 

LIMITATIONS ON LIABILITIES
RBTI will not be responsible for any costs or damages associated with loss of the use of the Program or
any other resources, loss of business or profits, any loss of data, any third-party claims or costs of
substitute programs. In no event will RBTI be liable for any incidental, indirect, special, consequential or
punitive damages suffered by the user or any other person or entity, whether from the use of the
program or documentation, any failure thereof, or otherwise, even if RBTI or its dealers or agents are
aware of the possibility of such damages. In no event will RBTI aggregate liability to you or anyone else
exceed two times the license fee you paid for the program and documentation in this package. Because
some states do not allow the limitation or exclusion of implied warranties and liabilities for consequential
or incidental damages, the above limitations may not apply to you.

GENERAL
This License Agreement constitutes the full and complete agreement between parties. RBTI retains all
rights not specifically granted herein. RBTI shall not be deemed to have waived any of its rights
hereunder or under all copyright laws, trade secrecy laws or otherwise. This Agreement is intended as a
legally binding agreement which will be enforced to the full extent permitted under applicable law, in
whole or in part. If any one provision of this Agreement is declared invalid or unenforceable, all
remaining provisions shall never less remain in effect. The laws of the state of Pennsylvania shall govern
this Agreement. RBTI reserves the right to amend, alter, or revoke this agreement at any time. All
revisions to this license agreement are available for inspection upon request, supersede conditions in all
past agreements, and render prior license agreements void and unenforceable. Both parties named in
this license will only be bound to the terms of the most current revision of this agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication or disclosure by the Government, its agents or employees is subject to all restrictions
imposed by law, regulation or government directive, including but not limited to those restrictions set
forth in DFARS 252.227-7013 and 48CFR 52.227-19, as applicable.

R:BASE Technologies, Inc.
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https://www.rbase.com
rbaseinfo@rbase.com

Copyright 1982-2024 R:BASE Technologies, Inc. 
All Rights Reserved
Revised Friday, April 26, 2024

1.4 Complimentary Support

30 DAY LIMITED COMPLIMENTARY TECHNICAL SUPPORT

A. LICENSEE RESPONSIBILITIES.

1. To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase. Proof of purchase is defined as the following: registration number, purchase
date, version and build number, and company or individual to which product is registered.

2. To have operating system, workstations, and local network installed and functional. R:BASE
Technologies will NOT be responsible for resolving issues not pertaining to the software product.

3. Our support staff deals with advanced issues, therefore the person contacting R:BASE Technologies
for assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

4. To have the database, application, and command files being reviewed, safely backed-up before
attempting assistance. R:BASE Technologies will NOT be held responsible for lost data or corruption
as a result of advice given.

B. R:BASE TECHNOLOGIES, INC. RESPONSIBILITIES.

1. To provide quality assistance in a timely manner to aid in the installation of the product and
elementary conversion of database, application, and command files within 30 days of the date of
purchase.

2. To provide a reasonable solution for any solvable issue. Not all issues may be solved, and
therefore we will acknowledge the existence of known issues, or bugs, which we are presently
aware of, that have no reasonable work-around.

R:BASE Technologies reserves the right to limit the amount of support time allotted to a maximum of 2
HOURS during the 30-Day Complimentary Technical Support period. We also reserve the right to limit the
quantity of calls from a particular licensee to 30 MINUTES in a single day. Issues are dealt with on a
case-by-case basis, and are handled at the discretion of the support agent assigned to the case.
Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related issues ONLY.
Our support hours are Monday through Friday, from 10:00 AM to 6:00 PM (EST).

For application, design, or advanced conversion assistance, R:BASE Technologies offers Technical
Support Plans of various types to meet your needs. Please visit the Support page at
https://www.rbase.com/support for details and pricing.

https://www.rbase.com/support
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2 Installation

2.1 System Requirements

The following system specifications are recommended for the optimal use of R:BASE and R:BASE-related
software. 

Workstation Hardware

· 2-Core 2GHz+ CPU
· 2 GB of available RAM (4 GB recommended)
· 2 GB of available hard disk space
· 1024x768 or higher resolution video adapter and display
· Standard mouse or compatible pointing device
· Standard keyboard

Server Hardware

· 2-Core 2GHz+ CPU
· 6 GB of available RAM (8 GB recommended)

Operating System

· Microsoft Windows 11 (Professional)
· Microsoft Windows 10 (Professional)
· Microsoft Windows Server 2022
· Microsoft Windows Server 2019
· Microsoft Windows Server 2016
· Microsoft Windows Server 2012, 2012 R2

Network

· Ethernet infrastructure (Gigabyte recommended)
· Internet connection recommended, but not required, for license activation, software updates, and

support
· Anti-virus programs should exclude the R:BASE program, and any add-on product, executable and

database files

2.2 Software Installation

The installation of the R:BASE Dependency Viewer is fully automated and does not require user
intervention for the initial setup. 

Run the installer ".exe", provided by download, while physically sitting at the workstation to begin the
installation process, and read the installer screens for licensing and other information as the program
installs.

Installation Directory   

C:\RBTI\RDependencyViewer11

Files Installed
 

RDependencyViewer11.exe
RDependencyViewer11.chm 
RDependencyViewer11.pdf
License.rtf 
ReadMe.txt
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3 Using the Dependency Viewer

3.1 Tool Bar

Button Description

New Model [Ctrl + N]

Open Model... [Ctrl + O]

Save Model [Ctrl + S]

Save Model As... [Shift + Ctrl + S]

Displays the Page Setup dialog for printer output,
prints the model, or sends the model to a PDF file

Connects/disconnects databases, and displays a list
of recently connected databases

Imports the database structure for the connected
database

Refreshes the database relationships

Adds a new image, note, or region to the model

Centers the objects within the model's dimensions,
and displays the Navigation Tool

Alters the cursor to select and move objects

Alters the cursor to drag the model 

Alters the cursor to move objects, especially
regions

Alters the cursor to resize objects

Deletes the selected object

Zooms in

Zooms out

Applies a zoom filter by percentage

Opens the R:BASE Dependency Viewer model
settings

Displays the R:BASE Dependency Viewer in-line
help documentation

Displays current information about the product
such as version

Closes the R:BASE Dependency Viewer program

3.2 Navigation Tool

The Navigation Tool displays the model and the area currently being displayed. The preview area be
zoomed in and out using the slider object. To display the Navigation Tool, select "View" > "Navigation
Tool" from the toolbar.
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When the zoom percentage display is higher and the navigation square is smaller than the model, the
blue navigation square can be dragged to specific areas of the model allowing a clearer view of the
model's tables.
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3.3 Importing a Database

The first step to working with the R:BASE Dependency Viewer is to connect to a database and import the
structure.

To connect to a database, select "Database" > "Connect" from the Tool Bar.

A dialog will be displayed to browse the computer for a database structure file (.RB1). After the
connecting, the database name will be added to the status bar across the bottom left corner of the
R:BASE Dependency Viewer window. 

Next, import the database structure by selecting the "Import" button from the Tool Bar.

The tables defined for the database will appear from top to bottom and left to right in alphabetical order.
The table with a constraint or index will be listed first with a blue and white gradient background for the
table caption. Tables without a constraint or index will be listed at the bottom with a grey and white
gradient background. ODBC Server tables will have a green caption. dBase tables will have a brown
caption. 

Table names appear in the caption for each square. Also listed in the table caption is an arrow for
expanding the full table column and constraint list. The table objects can be dragged around the model
background using the mouse. 

Relationship lines will link to the tables where references are implemented. By default, a character is
located on each line where a table is referenced by another  table. 

The table objects will appear similar to the image below. 
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3.4 Model Relationships

After a database is imported into a model and tables are displayed, the dependencies can be reviewed.
By default, a character is located on each line where a table is referenced by another table. 

When a table is selected, a red border is displayed around the objects that reference the object selected.
Green shading around a table object shows the objects that the object you selected references. 

In the image below, the BluzVan sample database is used where the Albums table object in the center is
selected. The Inventory, Orders, and SongList tables have a green border as they reference the Albums
table. The Artists and MusicType tables have a red border as the Albums table references them.
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3.5 Image Properties

Images can be added to the database model. To add an image, select the "Image" button from the Tool
Bar

Then, after using the mouse to click on the model where the image will be located, a dialog will be
displayed to browse the computer for an image.

After the image is added, the image properties can be changed by right clicking on the image and
selecting "Edit..."
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· Object Name - specifies the image
object name

· Image to Load - specifies the image
that can be loaded into the object

· Options - specifies image options

o Center - centers the image in the

object
o Proportional - resizes image to

the proportions of the containing
control

o Transparent - allows the

background to become
transparent to the parent object

o Stretch - resizes image to fill

entire object

· Comments - specifies comments for
the image object 

Moving and Resizing
The image can be moved around the model and resized to different widths and heights. Use the "Move"
and "Resize" options to perform these tasks. 

3.6 Note Text Properties

Notes can be added to the database model. To add a note, select the "Note" button from the Tool Bar.

Then, after using the mouse to click on the model where the note text will be located, the model object
will appear.

Right click on the added note text and select "Edit..." to view the note text properties.

· Object Name - specifies the note text
object name

· Font Color - specifies the text font
color

· Note Text - specifies text to be
displayed on the model

Moving and Sizing
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The Note Text can be moved around the model. Use the "Move" option to perform this task. The size of
the Note Text object is based upon the text that it contains and cannot be resized to different widths and
heights. 

3.7 Region Properties

To group objects together, regions can be added to a database model. Once an object is contained within
the region borders, it becomes part of the region and is affected by anything that occurs with the region.
If the region is moved or deleted, the objects within the region will also be moved or deleted. 

To add a region, select the "Region" button from the Tool Bar.

Then, use the mouse to click and drag the region size that is needed for the model. The region will
appear. Right click on the added region and select "Edit..." to view the region properties.

· Object Name - specifies the region
object name

· Color - specifies the background
color

· Comments - specifies comments for
the region

Moving and Resizing
The region can be moved around the model. Use the "Move" option to perform this task. When the region
is moved, any objects completely enclosed within the regions border will also be moved. The region can
be resized to different widths and heights. Use the "Resize" option to perform this task. 

3.8 Relationship Properties

When the database tables are first displayed, all table relationships are linked. The properties for each
relationship can be altered.
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· Object Name - specifies the
relationship object name

· Line Color - specifies the line color
· Font Color - specifies the text

caption font color
· Options - specifies relationship

options

o Referenced To - displays an

object on the relationship object
where the linking column is
referencing to

o Referenced By - display an

object on the relationship object
where the linking column is
referenced

o Split - splits the line linking the

tables
o Show Caption - displays the

relationship caption
o Show Relationship Icon -

displays the relationship icon

· Comments - specifies comments for
the  relationship object 

3.9 Page Setup

The Print Preview dialog allows users to adjust several settings to print the model. The width slider
control at the bottom of the dialog allows for the model to be displayed across multiple pages of printer
output.
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3.10 PDF Setup

The "Print" > "to PDF" option allows users to print the model to a PDF file, with various preferences,
content, background, and viewer options.
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3.11 Model Settings

· Model Name - specifies
the model name

· Model Comments -
specifies comments for
the model

· Model Size - specifies the
model width and height

· Snap to Grid - toggles the
snap feature for aligning
objects to the grid

· Table Display Mode -
toggles the display of
indexes, constraints, and
columns

· Display Paper Grid -
toggles the model
background display of a
divided grid based upon
into the necessary paper
height and width needed
for printer output

· Show Foreign Keys -
toggles the display of
defined foreign keys 

· Display Table Indexes -
toggles the display of
defined indexes
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4 Technical Support

Please read over the help documentation at least once before seeking support. We have worked very
hard to make the help documentation clear and useful, but concise. It is suggested that you reread these
instructions once you have become accustomed to using the software, as new uses will become
apparent.

If you have further questions, and cannot find the answers in the documentation, you can obtain
information from the below sources:

· Email our Technical Support Staff at: support@rbase.com
· Access the R:BASE Technologies Support home page online at https://www.rbase.com/support

You may be required to purchase a technical support plan. Several support plans are available to suit the
needs of all users. Available Technical Support Plans

Please be prepared to provide the following:

· The product registration number, which is located on the invoice/order slip for the purchased product
· The type of operating system and hardware in use
· Details regarding your operating environment; such as available memory, disk space, your version

of R:BASE, local area network, special drivers, related database structures, application files, and
other files that are used or accessed by your application

All provide information will be used to better assist you.

R:BASE Technologies has a number of different services available for R:BASE products. As a registered
user, you will receive information about new features for R:BASE and other R:BASE Technologies
products. Please remember to register your software. https://www.rbase.com/register/

mailto:support@rbase.com
https://www.rbase.com/support
https://www.rbase.com/support/plans.php
https://www.rbase.com/register/
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5 Useful Resources

. R:BASE Home Page: https://www.rbase.com

. Up-to-Date R:BASE Updates: https://www.rbaseupdates.com

. Current Product Details and Documentation: https://www.rbase.com/rbg11

. Support Home Page: https://www.rbase.com/support

. Product Registration: https://www.rbase.com/register

. Official R:BASE Facebook Page: https://www.facebook.com/rbase

. Sample Applications: https://www.razzak.com/sampleapplications

. Technical Documents (From the Edge): https://www.razzak.com/fte

. Education and Training: https://www.rbase.com/training

. Product News: https://www.rbase.com/news

. Upcoming Events: https://www.rbase.com/events

. R:BASE Online Help Manual: https://www.rbase.com/support/rsyntax

. Form Properties Documentation: https://www.rbase.com/support/FormProperties.pdf

. R:BASE Beginners Tutorial: https://www.rbase.com/support/rtutorial

. R:BASE Solutions (Vertical Market Applications): https://www.rbase.com/products/rbasesolutions

https://www.rbase.com
https://www.rbaseupdates.com
https://www.rbase.com/rbg11
https://www.rbase.com/support
https://www.rbase.com/register
https://www.facebook.com/rbase
https://www.razzak.com/sampleapplications
https://www.razzak.com/fte
https://www.rbase.com/training
https://www.rbase.com/news
https://www.rbase.com/events
https://www.rbase.com/support/rsyntax
https://www.rbase.com/support/FormProperties.pdf
https://www.rbase.com/support/rtutorial
https://www.rbase.com/products/rbasesolutions
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6 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like a software product to do
differently. 

If you come across an idea that you think might make a nice enhancement, your input is always
welcome.

Please submit your suggestion and/or enhancement request to the R:BASE Developers' Corner Crew
(R:DCC) and describe what you think might make an ideal enhancement. In R:BASE, the R:DCC Client is
fully integrated to communicate with the R:BASE development team. From the main menu bar, choose
"Help" > "R:DCC Client". If you do not have a login profile, select "New User" to create one.

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the request. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted enhancement request. 

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

Reporting Bugs:

If you experience something you think might be a bug, please report it to the R:BASE Developers'
Corner Crew. In R:BASE, the R:DCC Client is fully integrated to communicate with the R:BASE
development team. From the main menu bar, choose "Help" > "R:DCC Client". If you do not have a login
profile, select "New User" to create one.

You will need to describe: 

· What you did, what happened, and what you expected to happen
· The product version and build 
· Any error message displayed
· The operating system in use 
· Anything else you think might be relevant 

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the bug report. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted bug.

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

mailto:rdcc@rbase.com
mailto:rdcc@rbase.com
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options     17

- P -
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